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Introduction  
 
MultiEx Commander is a tool that will enable you to open game resource archives 
(GRAs) to examine their content. Games mostly come with GRAs that contain 
resources, such as sounds, music files, textures and scripts. These archives can be 
very large files, in most games, but it depends on their specific content. GRAs come in 
many different formats, depending largely on the authors of the game, and one could 
try to create a new viewer or extractor for each new GRA encountered. The strength 
of MultiEx Commander lies in its power to handle a vast amount of different GRA 
formats (GRAFs) at once. Supporting hundreds and hundreds of different games, of 
which the majority can also be edited, MultiEx Commander is unique in the world. 
Note that many if not most of the supported GRAFs have also been applied to pack 
copyrighted resources in a GRA. What MultiEx Commander does is offer a way to 
unpack and alter game archives, but does not support in any way illegal unpacking or 
alteration of GRAs that contain copyrighted material. As a user, you should read the 
manual of each game carefully, before you use MultiEx Commander to open and 
possibly alter its archives. Doing so may be forbidden, and the authors of MultiEx 
Commander will not take responsibility for such actions. Always consult the company 
that holds the rights to copyrighted material contained in GRAs before you do some 
public and heavy modding. Please read the legal disclaimer carefully! 
 
The MultiEx Commander interface is pretty straightforward, with basic operation 
(viewing, extracting) much in the same way as other archivers around, such as 
WinRAR, WinZip. Advanced operation (resource replacement and addition, creation 
of new GRAs) is done from within the MultiEx Editor. The EasyMod feature will 
allow the user to create standalone mods to distribute to others!  
 
Create custom new support  
 
Advanced users and programmers can create new GRA support themselves after they 
take the time to learn MexScript, the „language‟ that MultiEx uses to process game 
archives. Alternatively, you can also use QuickBMS scripts (a MexScript derivative). 
Finally. two other options to support new games are by programming ActiveX DLL 
plug-ins or Rahly Plugins for MultiEx Commander. The average user, however, need 
not be concerned with these matters and can just use it to handle already existing 
supported game archives.   
 
The program allows for previews of graphics, music, text and sound, and can also 
convert them to certain other types.  
 
Registration 
 
As a registered “Friend of MultiEx” you will receive a personal code that will enable 
you to download MultiEx Commander. Registration is possible by donation or other 
support of the project, like pointing out new formats, writing scripts, offering 
webspace, offering advertisements for MultiEx Commander on your website and 
more. Donation can occur via PayPal, and you will be send a registration key to your 
PayPal email address along with a download link. A lot of people have already 
become a Friend of MultiEx! 
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Why is registration needed? A lot of time, energy and money are spend to ensure 
support for new games, maintain the website and create new features for the user. To 
do this, the Xentax Foundation requires some support from the community.  
Login 
 

 
 
 
You will see the login window if you start the program. Use the email address you 
used to donate and the registration code to log on. You will need an internet 
connection to do this.  

 
Basic Operation 
 
MultiEx Commander operates on two levels. First, there‟s the basic operation window 
that is shown upon start-up. Here you can perform simple but effective resource 
extraction and previewing. At the top of the window you are presented with large 
buttons. The represent the following actions, from left to right: 
 

 
 
1. Open. Clicking on this button will show the Open Archive dialog. In this dialog 
you can browse to a file of interest and select to open it in MultiEx Commander.  
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Archives are processed via either scripts or plugins. There are two sources of scripts: 
MexScript (the original multiex script) and QuickBMS. The latter is only supported in 
a special script window (see Script) and not from the Load archive dialog. Now for 
instance, if you want to open C&C: Generals .BIG files in the Load Archive dialog, you 
open the Select file type drop-down menu, and scroll to „C&C: Generals (.BIG)‟. You 
can also open the menu and press „C‟ to quickly go to that letter, to speed up selection. 
When you have selected the game archive type of your choice, select the file you wish 
to open. When satisfied, click Open to open the file. Note that only those files are 
shown in the folders that match the chosen format‟s extension. If you wish to see all 
files then type *.* in the Filename textbox. If you chose (*.*) from the Select file type 
drop-down menu, you will open any file as a single binary in MultiEx Commander 
(you can to this to completely replace the contents of that file in MultiEx Editor) 
When satisfied, click Open to open the file. To abort, click Cancel.  
 
2. Extract. When you have opened a file of your choice, the main window will list the 
contents. You can now press the Extract button. Doing this immediately after you 
have just opened a file will extract ALL files. By default, all files are selected. If you 
left-click on a resource in the archive (without holding any other keys), only that file 
will be selected. You can hold down CTRL or SHIFT to select multiple files of your 
choice. If you are satisfied with your selection, press the Extract button to show the 
Extract dialog. You can now point to a directory of your choice, and create a new one 
if you wish to do so. If you are done, click „Ok‟ to start extraction of the currently 
selected files into the directory you have chosen. You can also „Cancel‟ and return to 
the main window without extraction. 
 
3. MultiEx Editor. If you wish to switch to advanced mode, you use this button. 
This offers much more handling. See Advanced Operation for details.  
 
4. Options. You can set a number of options in MultiEx Commander, see MultiEx 
Commander Options for details.  
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5. View. Finally, the last large button in the basic operation window is the „View‟ 
button. Whenever you click on a resource in the archive, MultiEx Commander will 
perform a check whether files with this particular extension are associated with any 
program in windows. For instance, if a resource would have the following name, 
„scripts.txt‟, MultiEx Commander would probably find that a file with the extension 
.txt is associated with Notepad.exe. If and when MultiEx Commander finds that the 
extension is indeed associated with a program on your computer, the „View‟ button 
will be enabled. Clicking the „View‟ button will have the same effect as double-clicking 
the resource; the resource will be extracted temporarily and opened in the program 
that is associated with it. In the above mentioned example, MultiEx will start 
Notepad to show the „script.txt‟ resource.  
Note: the buttons as discussed may sometimes be disabled. You can see this 
whenever there is a cross through the button in question. Naturally you cannot 
extract anything when there’s no open GRA, sometimes the MultiEx Editor cannot 
be started because the file in question is not supported by MultiEx Editor and 
finally, as already mentioned, the ‘View’ button will be disabled if there’s no 
program associated with a selected resource. 
 
New Archive.  
You can create a new game archive (if it is supported for that feature) by going to the 
File menu and selecting New. Then follow the on-screen instruction shown by the 
Wizard to create the new archive. This will be automatically opened in MultiEx 
Commander after creation.  
 
Extract table of contents.  
Whenever you have opened an archive and wish to see a list of its contents any other 
time outside of MultiEx Commander, go to the File menu and choose the Extract 
table of contents option. You will save the TOC as a Tab-delimited text file that you 
can open in any text editor or spreadsheet. Handy to show others what you found!  
 

Advanced Operation : MultiEx Editor 
 

 
 
The panels 
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When switching to MultiEx Editor you will see the tool buttons to the left, and two 
panels, one file explorer panel, and one panel that will list the contents of an archive 
(resource panel). You will also notice that two other windows are there: the Preview 
panel which will present previews of files and resources, and EasyMod: the tool to 
create standalone mods for your games.  
  
Clicking on a file or a resource will start the automatic preview of that item in the 
Preview window. There you will see images, text, or listen to sound and music. You 
can also save stuff in the Preview window in other file formats (i.e. the images). Music 
and sound you can play or stop using the Play and Stop buttons that will be displayed 
whenever audio files are previewed.  
 
Below the two main panels in the MultiEx Editor window you will find quick-
operation buttons. The Target for replacement button is the rightmost button below 
the file explorer panel (with an arrow to the right). Any file that is currently selected 
in the file panel will be used to replace a resource selected in the game archive (the 
right resource panel) when this button is clicked. You will notice that the resource 
panel has a number of columns. The first column lists the potential files to be used to 
replace the item that is listed, typically all read “<not replaced>” when you first start 
the editor. By double-clicking on the items in this column, or by clicking the Target 
for replacement button you can set the currently selected file to be used as 
replacement for the currently selected resource item. You first choose all the items to 
be replaced by files, after which you can start the actual process of replacement. Note 
that this will only work when the particular archive is supported for replacement 
(which is different from „adding‟ a file to an archive).  
The Batch button will start the Batch dialog that can target multiple resources for 
replacement by files in a specific folder. And finally, the Open As button can be used 
in conjunction with the file type drop-down box next to it to open a currently selected 
file in the file explorer panel.  
The Quick-extract button (an arrow pointing to the left) below the resource panel is 
used to extract the selected item(s) in the resource panel to the current folder of the 
file explorer panel.  
 
The menu options 
 
From the top MultiEx Editor menu you can choose:  
 
File    Open Archive (start the Open Archive dialog) 
Tools   Import batch from folder  
   Scriptor 
View   Show EasyMod window 
   Show Preview window 
Options  Test run editing only 
 
 
The toolbar 
 
The left part of MultiEx Editor comprises of a toolbar with the main controls. Game 
archives that were opened by multiex.dll, the main processor of archives in MultiEx 
Commander, can only be altered using these buttons, whilst game archives that 
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required a dll-plug-in for processing can have additional options. The first button is 
the View button. When you click on any item in the two panels, you not only see a 
preview of it, when possible, but you may also see the View button enabled. This 
means that files of this type have been associated with some kind of program on your 
computer and you can open the file in this program. For instance, an item called 
“myitem.txt” may be opened in a program associated with text files, in many 
instances NOTEPAD.EXE. By clicking the View button you will open “myitem.txt” in 
that external program. Recall that you can see which program is associated with the 
item you clicked in the preview window, or at the bottom of MultiEx Editor (shown in 
the status bar of each panel). The second button on the toolbar is the Replace current 
targets button. Click this when you want to replace existing resources with files you 
specified in the resource panel (i.e. targets for replacement). Thus, when you are 
satisfied with the targeting, replacement will commence after you click the button, 
but beware that you can simulate this first. To simulate, go to the Options menu and 
select Test run editing only.  Now, when you start the replace process, no data will be 
written to the resource file.  
Finally, the Clear all targets button will remove any targets in the target column of 
the GRA panel. If for some reason you wish to start over, click this button, and any 
resources targeted for replacement will be cleared.  
 
Scriptor 
 
You can start the scriptor from either the Basic Operation window or MultiEx Editor.  
In MultiEx Editor you select Tools from the top menu and then click on Scriptor.   
 

 
 
With the scriptor, you can write, load and save your own MexScripts to open archives. 
Or, perhaps someone else wrote a script (like at the Game Research Forum, 
http://forum.xentax.com ) and you wish to use it yourself. When you‟re writing your 
own script, you can check it for mistakes by clicking the Check script button. MultiEx 
will then be started and a check is done. To really debug your script while running it 
on an archive, you can check the Enable debugger box.  To run the script on a file, 
click on the Use on button. Upon successful completion the file will be open in the 
program and you can extract (and replace if possible) the resources.  
 

http://forum.xentax.com/
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QuickBMS can also be used. QuickBMS script is a MexScript derivative by Aluigi. He 
wrote a command-line tool, QuickBMS to open archives. With the Scriptor in MultiEx 
Commander you can use that script style to open files as well. Make sure you select 
the QuickBMS or MexScript option as appropriate.  
 
 
Additional plug-in options 
 
MultiEx Commander runs largely on multiex.dll, a dynamic link library that 
processes the multiex scripts to use on different game archive formats. However, it is 
possible to write ActiveX/Rahly plug-ins for MultiEx Commander, which can have 
additional options to alter or work with game archives. For instance, the Painkiller 
PAK game archives are supported by such a DLL, which offers Creation of new PAK 
files, Addition of resources to existing PAK files and deletion of resources in existing 
PAK files, besides the basic Replacement of resources and Extraction of resources. 
Whenever an archive of your choice is processed by such a DLL and there are 
additional options besides the basic ones, you will notice the Advanced  Options 
button is visible in the toolbar. This is a drop down menu from which you may select 
the options, such as Create new archive, Add selected files to archive and Delete 
selected resources. For your convenience, quick-tap buttons are also placed right 
below the archive contents panel. When supported, they will be enabled.  
 
Creation Wizard 
 
By clicking Creation you will be presented with a Creation Wizard that will ask you to 
specify creation parameters. These parameters were queried by the DLL, and it needs 
these specifications before it can successfully complete your request. The Creation 
Wizard shows you the list of values to specify along with the description of these 
values (two columns).  
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Click on the Value items to change them. For instance, you will probably see a value 
that represents the filename of the archive to create. Click on the value to be 
presented with a new dialog in which you can specify how you wish to name the new 
archive. Alternatively, you may click on the Change button to alter any values you 
have currently selected. Values can represent Booleans (Yes/No), Filenames or text 
strings. When you are satisfied with the set options, you must select the Continue 
button to start the actual creation. You may Cancel at any time to abort the creation 
process.  
 
If supported by the plug-in, you can Add files selected in the file panel to the 
resources in the archive. Note that all the files selected will be inserted after the 
resource currently highlighted in the right resource panel. Alternatively, it may be 
possible to Delete resources from a file. Just select all the resources you wish to delete 
and select this option. The plug-in will do the rest.  
 
As the plug-in is an external program its process runs independently of MultiEx 
Commander. It may take a while! MultiEx Commander Ops are suspended until the 
plug-in completes its task. Please wait until it is done.  
 
Batch replacement 
 
Batch replacement is available from the Tools menu or the Batch button below the 
file explorer panel in the MultiEx Editor window. With this tool you can point to a 
directory of your choice to scan for files identical in name than resources in your 
archive. Any match will be targeted for replacement by the found file. This can come 
in handy if you wish to bulk-replace resources you have just edited. More specifically, 
you can opt to extract all resources of a GRA into a directory of your choice (either 
using the basic MultiEx Commander window or the MultiEx Editor), open and edit 
the resource you wish to change using some external program, without changing its 
name. When you are done editing the resources, you can run the Batch Replacement 
tool to target the resources in the GRA for replacement with your edited ones. Note 
that the tool will only set the targets; you will still have to hit the Replace current 
targets button in MultiEx Editor to start the replacement. 
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EasyMod Creator 
 

 
 
With the EasyMod Creator you can make a quick stand-alone mod for a game that 
has archives supported for resource replacement. From the File menu you can start a 
new project (a new is started by default). You can also save and load projects from 
there or use the buttons.  
The process is as follows.  
 

1. First of all you need to tell EasyMod what the root folder of the game is. To do 
so, click on the Game root folders node in the window to have it selected, and 
then click New Game folder in the Actions frame. You will be presented with a 
dialog that has you pointing to the main folder of the game. Usually this is 
where the game‟s executable is.  

 
2. You then select the newly created game folder node and click on Add active 

edited file. This will add the currently open archive in MultiEx Editor along 
with all the resources that are targeted for replacement to the project. So, 
make sure you have targeted all resources in the current file that you wish to 
alter before you click this button. Note that this will NOT change the current 



MultiEx Commander 4.5 User’s Manual  

 13 

archive at all, it will be like a test run. But the information will be stored in the 
EasyMod project.  
 

3. You can open another archive of the game and target resources for 
replacement, and then add that file to the game folder node as well. You can 
repeat this many times.  
 

4. When you are satisfied that this is the mod you wish to create, make sure you 
fill in the ModName and Author fields. This will be shown in the EasyMod. 
Then click Create EasyMod. Select the folder where you wish to save the 
EasyMod and click ok. Wait for the process to complete. When it is done, you 
will have a zip-compressed file at that location that you can distribute to 
others! It contains a few DLLs, the EasyMod executable and a data file. Users 
that wish to mod their game with it need only unpack it in the main folder of 
the game and start EasyMod.exe.  
 
 

EasyMod Stand-alone game mod 
 

 
 
 
A created EasyMod can be run to alter a game‟s files as intended by the author of the 
mod. Run it to do so. You will see the EasyMod window where you can click on View 
advanced to see which files will be altered, or to see which file has a problem. 
Whenever the status frame says Ready to go! you can click Start to run the 
modification. By default, Backup files is checked and each file is backed-up before 
change. If something goes wrong and you can no longer start the game in question, 
run EasyMod again. It will give you the option to restore the files to its original state.  
 
EasyMod runs a check on the files it will change. This is the File Signature of each file 
in the mod, that was saved when the EasyMod was created. If the Signatures stored 
do not match the files it finds it will ask for your permission first when you run it. 
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This is all at your own risk from that point on. The status frame will tell you when a 
file could not be found, or when a file was found, but the signature invalid.  
 
Note that the signature covers a lot, but may not always show a mismatch with 
100% certainty. It is often still advisable to store the files that will be altered 
somewhere save as a double-backup when something is wrong after you ran 
EasyMod.  
 
In the event the EasyMod was not unpacked from its ZIP file in the main game folder, 
it can happen that certain files it wishes to change are not found. You can then click 
View Advanced and select the Change button in the Game Folder frame to look for 
the right folder.  
 

Options 
 

 
 
There are a number of options you can set in the main options window, but these 
represent not all options. As you will see, you can choose additional tools and 
information from the program‟s main menu.  
 
First the options in the option window.  
 
Check for overlapping files 
 
For extraction and processing of previews, you can tell MultiEx Commander to check 
whether subsequent files/resources overlap or not. If one resource overlaps the other 
in a GRA, MultiEx Commander will assume it is corrupt and not extract. Uncheck this 
if you don‟t wish MultiEx Commander to do that.  
 
Ignore 0 sized files 
 
Check this to ignore resource entries that are 0 in length. Usually these will be 
identifiers of directories and need not be extracted.  
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Extract compressed if fail 
 
When decompression of compressed resources fails, for instance when not all 
resources are actually compressed, checking this box will step over an error message 
and extract the resource in its compressed state.  
 
Game extractor plugins 
 
You can chose to have MultiEx Commander look for Game Extractor and use it‟s 
plugins to open archives as well. Enable this by checking the box.  
 
MultiEx Debugger 
 
You can turn on the MultiEx debugger when it processes the script to open an 
archive. However, this is only handy to debug a script.  
 
Debugmode  
 
Check to start or don‟t start the debug mode on start-up of MultiEx Commander. 
When started, MultiEx Commander will keep a process log in its “data” directory, 
which you can also view from the Log-menu in the main window, or from the 
Options window (“View log”). 
 
Importation flag override 
 
Check this to ignore the script flag that informs MultiEx Commander whether the 
script is capable of supporting replacement of resources or not. This should be used 
with extreme caution as a stupid move on a file that was not supported for resource 
replacement may corrupt it.  
 
Autosave 
 
You can tell MultiEx Commander to keep additional process logs besides the 
mentioned Debug-log. Check the ones you wish to keep and/or view them.  
 
Languages 
 
You can select different languages for the main user interface here.  
 
Save and Exit 
 
Click to save the current settings and go back to the main window.  

 
Additional Options  
 
In the main window (the Basic operation) there are a number of other things you can 
do using the following menus on top.  
 
Edit  Find 
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From here, you can start the search dialog that can help you locate and select certain 
file types. You can give characters to look for, extensions or types. Click Ok to search 
for those and all matched will automatically be selected when returning to the Basic 
operations window.  Click Cancel to go back without searching.  
 

 
 
Web  
 
Check web for new version 
 
Contact the XeNTaX website for news on updates. Update will occur automatically. 
You must be connected to the internet for this to succeed.  
 
Visit the discussion forum 
 
This will start your internet explorer and go to the MultiEx Forum at 
http://forum.xentax.com 
 
Visit the MultiEx website 
 
This will start you internet explorer and visit XeNTaX at: 
http://multiex.xentax.com 
 
Tools Menu 
 
The Tools menu offers an important selection of tools.  
 
File Association Preferences 
 
In the Tools menu, you can edit the file association preferences of MultiEx 
Commander with files of supported file extensions.  
 

http://forum.xentax.com/
http://multiex.xentax.com/
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Simply check any and all file types you wish to be able to double-click from windows 
and automatically send to MultiEx Commander. In addition, You can Check All at 
once, Uncheck All at once or Check only those that are not associated yet 
(”none”). Click Ok to save these settings in the windows registry, or Cancel to abort.  
 
View Detected Plugins 
 

 
 
This will show which information about the plugins (MexCom plugins, or Rahly‟s 
Pluginmanager plugins) that have been detected. Use the tabs to switch to either 
plugin type.  
 
Preview 
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Checking Autopreview on in the basic operation window of MultiEx Commander, or 
from the View menu in MultiEx Editor will show the preview of any picture, sound or 
text you click in an archive or folder. The picture previews you can use to convert the 
pictures to different picture types (BMP, JPG, PCX, TIF, TGA, SGI, DDS, PNG, OIL, 
RAW). Sound files you can start and stop using the large buttons in the preview 
window. 
 
 

Scripts  
 
From the Scripts menu MexScript related tools are on offer. MexScript is the main 
script that is used by MultiEx Commander to process game resource archives. When 
MexScript *.TXT files are  subsequently compiled to a format that is understandable 
to the interpreter, it becomes Binary MultiEx Script (BMS). Do not mistake this BMS 
with QuickBMS files. QuickBMS *.BMS files are also text files like MexScript, and not 
binary files.  
 
Scriptor 
 
This is a handy feature for the pro‟s among you. It will start the Scriptor.  
You use this to write your own MexScript or QuickBMS to run on files.  
 
Run Binary MultiEx Script (BMS) on 
 
For those of you that work with MexScriptor, the scripting program was previously 
used to create scripts that MultiEx uses to process archives there‟s still the option to 
open a game resource archive of your choice with the compiled version of MexScript. 
Simply select the BMS file first, then the archive. Use at your own risk though.  
 
Show text interpretation of Binary MultiEx Script (BMS) file 
 
This will interpret the process of a BMS file and show a file structure of the archive 
that is opened by that script.  
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The Help Menu  
 
Finally, the help menu offers a range of information, such as a list of all the formats 
supported, this help file, the End-user license and the About screen and a note for 
game developers.  
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Creating your own ActiveX DLL Plug-in (MexCom Plugin) 
 
As a programmer, you can create your own ActiveX DLL to include additional games 
for support within MultiEx Commander. Thus, if you know how to handle a GRAF 
that is not supported yet by MultiEx Commander, you can make one yourself this 
way.  
 
For MultiEx Commander to be able to work with it there are a number of things that 
need to be taken care of.  
 
1. Create a directory in the plug-in dir of MultiEx Commander 
 
Create a directory named after the extension of the GRA you wish to support, if it 
does not exist yet. So, if you want to support a *.LIB file from Game A, you create a 
dir named “lib” in the plug-in dir. Inside the lib directory you will copy your DLL, that 
will ave the name of the game. So, in the above example you would copy the dll as 
“gamea.dll”. 
 
2. Provide the necessary functions MultiEx Commander wants to call 
 
For MultiEx Commander to work with the DLL it will expect specific functions to call. 
Here‟s the list of functions it expects, defined as Visual Basic functions: 
 
The ActiveX DLL Plug-in Functions: 
 
Public Function bnPlug-info(Info() as string) 
 
bnPlugInfo will provide you with details on the plug-in processes.  
 
Info(0) = "Painkiller PAK Files Extractor" ' verbose meaning 
Info(1) = "2" ' type = 2 , meaning you can ask it to extract/import 
Info(2) = Major.Minor version number 
Info(3) = "1" ' allows importation (0 = no importation) 
Info(4) = "5" ' How many different variables will be returned 
Info(5) = "0" ' is there a resource type variable? (for the columns) 
Info(6) = "0" ' Create support (0 = no importation) 
Info(7) = "0" ' Delete support (0 = no importation) 
Info(8) = "0" ' Add support (0 = no importation) 
Info(9) = "0" ' Replace support (0 = no importation) 
 
From Info(10) on come the descriptions of the variables specified in  
Info(4). Example taken from Painkiller.dll: 
 
'Info(10) = "Filename" ' names of the variables returned (always at this position) 
'Info(11) = "Compressed" 
'Info(12) = "Offset" 
'Info(13) = "Uncompressed" 
'Info(14) = "Compression(%)" 
 
 
Public Function iGetCreateArchiveInfo(CreateInfo() As String) As Long 
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Will return a list of things you should ask the user before running a iCreateArchive or 
iCreateFromDir function. The list provides description and 
type in subsequent entries. So, if a plug-in wants a filename from the user,  
it would return :  
CreateInfo(0) = "Please specify filename"  
Createinfo(1) = "filename" 
etc. 
 
What the Plug-in can ask for when creating a new archive is 
really up to the plug-in These things MultiEx Commander can handle : 
'boolean'  : Will prompt the user for a Yes or No 
              (and return a 0 or a 1) 
'filename'  : Will prompt the user to specify a savename 
               (thus will return a string of the full path) 
'text'      : Will prompt the user to specify some text 
 
Public Function iList(strPath As String, iType As Integer, iStdList() As 
String) As Long 
 
Will return a list of all the stuff in the archive.  
 
- you give the path to the archive in strPath,  
- you provide the type of list it needs to return in iStdList(). 1 will be mostly used.  
- you return the contents in a list of strings  
This depends on the type you specify. MultiEx will expect type 1 and ask for type 1:  
 
List of contents Type 1 (iStdList):  
 
An array of strings:  
 
iStdList(0) = Number of files (in string-form, will need to be "File not supported" if 
the provided path can't be processed by the plug-in)  
iStdList(1) = path to the archive  
iStdList(2) = the name of the plug-in and its version number  
 
Then follow the actual entries, in sequential order.  
the first would be :  
iStdList(3) = Name of the resource in the archive (e.g. "textures\me.tga")  
iStdList(4) = Size of the resource in the archive (will be the COMPRESSED size in 
case the resources are compressed)  
iStdList(5) = Offset of the resource in the archive  
iStdList(6) = Uncompressed size of the resource (this is 0 if there's no compression)  
OPTIONAL iStdList(7) = % compression (compressed size/uncompressed size*100) 
NOTE that this will not be so in case of uncompressed files.  
In case of uncompressed files the next entry will begin at iStdList(7), in case of 
compression the next entry will begin at iStdList(8 ). 
 
Public Function iCreateArchive(strDes As String, CreateInfo() As String) 
As Long 
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WIll create a new archive strDes using the info specified in CreateInfo. Note that the 
CreateInfo you RETURN to the Plug-in needs only have the values! Do not also 
return the descriptions! 
 
Public Function iCreateFromDir(strPath As String, CreInfo() As String, 
Optional strDir As String) As Long 
 
Will create a new archive containing all files below a specified strDir. Provide the 
CreationInfo as asked for by the Plug-in.  
 
Public Function iDeleteResource(List() as string) As Long 
 
iDeleteResource deletes all resources specified in List(). Make sure you get the name 
of the resource exact. Note that iDeleteResource expects you to procide the list in 
order of appearance in the archive, depending on the plug-in.  
 
Public Function iExtract(strRes As String, strDes As String) 
 
iExtract searches for strRes in an archive and extracts it as strDes 
 
Public Function iImport(strRes() As String, strDes As String, Optional 
Number As Long = 0, Optional OverwriteNames As Boolean = False) As 
Integer 
 
iImport replaces a given resource matching the full name with the one(s) in the 
provided list and to the (new file) strDes.  
Note that the format of the strRes() is : 
(0) Name in PAK FILE of res1 
(1) Path to file to replace res1 
(2) Name in PAK FILE of res2 
(3) Path to file to replace res2 
etc. 
 
 
Public Function iAddResource(Where As Long, strPath() As String, 
strNames() As String) As Long 
 
iAddResource will insert a list of strPaths (files) as strNames at position Where in the 
archive. (Use strNames if you want to change the name of the file in the archive prior 
addition). 
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RPM Type Plugins (Rahly Plugins) 
 
At the time of writing there are no documents yet to explain how to create this type of 
plugin for MultiEx Commander and sites with examples are down. Just drop by at the 
forum and ask for support from Rahly.  
 

Troubleshooting 
 
For any issues, bugs and general help we advise you to visit the forums that exist for 
this purpose. You can find the MultiEx Forums here http://forum.xentax.com 
 

http://forum.xentax.com/
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Credits  
 
MultiEx Commander is shareware, with some original source code still available at 
Sourceforge.net (http://sourceforge.net/projects/mexcom). It was started in DOS 
and programmed in Turbo C in 1997 by Mike Zuurman (AKA Mr.Mouse) under the 
SadCom Ltd and XeNTaX label. In 2001 the first windows version was released, 3.0. 
3 years later version 4.0.0 was released. MultiEx Commander is developed from 
donations.  
The latest version is 4.5 (January 2011). MultiEx Commander is developed by the 
Xentax Foundation.  
 
Code:  
 
Mike W. Zuurman (MexCom)  
Jeremy Walton (Pluginmanager) 
 
Additional game support :  
 
Michael Watson 
KorNet  
PXR 
 
Xentax WIKI (Game File Format Central): 
 
Mike W. Zuurman 
Michael Watson 
Arjan Dikhoff 
Phillip Patriakeas 
  
About Soundbite: 
 
Voice of Duke Nukem: John Saint John 
Sound editor & story board: Mike W. Zuurman 
 
Third part components as used by MultiEx Commander: 
 
ZipIt (c) Richsoft  
ZLib (C) 1995-1998 Jean-Loup Gailly, Mark Adler 
BASS (C) 2003 Ian Luck, un4seen.com 
devIL (c) 2003 Denton Woods,imagelib.org, licensed under LGPL 1998-1999 
Chilkat XML (C) 2004-2005, Chilkat Software, Inc.  
Ariad (R) Explorer Controls (C) 1999-2001 by Ariad Software 
PECompact (C) 2006 Bitsum Technologies 
 
The main website of MultiEx Commander is http://multiex.xentax.com 
 

http://sourceforge.net/projects/mexcom
http://multiex.xentax.com/
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Legal disclaimer 
 
The user has agreed to the following terms on usage of MultiEx Commander: 
 
1. The MultiEx Commander product series (past and present) are  
licensed under a GNU public license. The MultiEx Commander  
product series will be referred to as all components installed  
by the MultiEx Commander installer, plus the installer itself,  
together named “MultiEx Commander” hereafter.  
 
2. The „user‟ is from now on defined as every living being (such  
as humans or other animals) that installs, runs, uses, operates  
and/or works with MultiEx Commander.  
 
3. The user agrees that Mike Zuurman and third party contributors, 
together referred to as „authors‟ hereafter, are in no way  
responsible for any physical damage done to anyone‟s computer  
hardware, software, physical body and other systems, or any other 
malicious event, that may or may not have become present after  
MultiEx Commander was installed and executed.   
 
4. The user agrees that the Xentax Foundation, SadCom Ltd.,  
Sourceforge.net and the authors of MultiEx Commander,  
together referred to as „producers‟ hereafter,  
cannot in any way be held accountable for  
any of the malicious events mentioned under (3) exactly as shown  
above that occur after usage of MultiEx Commander.  
 
5. As a user of MultiEx Commander you will agree to respect the  
international copyright laws that protect material (sounds,  
scripts, graphics, binaries, text, interfaces, referred to as  
„material‟ hereafter) contained in the game resource archives  
(named 'GRAs' hereafter) that can be processed by MultiEx Commander.  
 
6. The user agrees not to use MultiEx Commander to extract, copy, 
distribute or change copyrighted material from any GRAs without  
explicit permission from the company that holds the copyrights to  
that material or to the package format of the GRA.  
 
7. The user agrees to use any legally obtained material mentioned  
under (5) and (6) for his personal, domestic and non-commercial  
usage only, unless he has an agreement with the company that holds  
the copyrights to the material for commercial exploitation.  
 
8. The user agrees not to use MultiEx Commander to alter GRAs  
supported for processing by MultiEx Commander without specific  
permission from the holder of those GRAs‟ copyrights.  
 
9. The user agrees that the producers are not in any way legally  
responsible for users that process GRAs by MultiEx Commander  
illegally. Likewise, the producers are not in any way legally  
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responsible for illegal usage of copyrighted material extracted from  
GRAs that can be processed by MultiEx Commander. As such, the user  
agrees that the producers are not allegeable to file lawsuits against. 
  
10. The user takes full legal responsibility for any illegal act he  
or she may commit using MultiEx Commander and will free the producers  
of any legal obligation in the event of any law broken by the user.  
 
11. The user can support the Xentax Foundation by donation, either money 
or natural resources. As a token of gratitude the user will recieve a 
personal key that will unlock extra features in MultiEx Commander. The user 
becomes a Friend of MultiEx this way. The user agrees to the condition that 
the thus acquired personal code was not bought, but a gift from the Xentax  
Foundation as a return favour for any support that the user may have given 
to the Xentax Foundation. As such, the user cannot hold the Xentax Foundation 
responsible for a non-functioning key, or when the unlocked features are  
not to the satisfaction of the user or do not function correctly.   
 
12. The user agrees that he has no rights to claim from the producers by  
downloading or using MultiEx Commander.   
 
If you agree with all of the above click "I agree" to 
continue the MultiEx Commander package.  
if you do not agree with all of the above click "I don't agree" 
to close the MultiEx Commander package without using it.  
 
 


